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 Preface 

• 

Since its inception, AutoCAD has enjoyed a large user base, which has made it the most popular CAD software in the world. AutoCAD is widespread due to its logic and simplicity, which makes it easy to learn. AutoCAD evolved through the years to become a comprehensive software application addressing all aspects of engineering drafting and designing. 

• 

This book addresses all levels of AutoCAD 2D drafting, Essentials, Intermediate, and Advanced, which makes it ideal for novice users, and for those seeking to be professional power users ready for industry. 

• 

This book is not a replacement of AutoCAD manuals, but is considered to be complementary source that includes hundreds of hands-on practices to strengthen the knowledge learned and solidify the techniques discussed. 

• 

At the end of each chapter, the reader will find “Chapter Review Questions” 

which are the same sort of questions you may see in the Autodesk certification exam; so, the reader is invited to solve them all. Correct answers are at the end of each chapter. 

• 

Chapter 10 contains three projects: one is an architectural plan, presented in metric and imperial units. The other two projects are for mechanical engineering. One of them is thoroughly explained and the other is not! These two projects are also presented in both metric and imperial units. 







 About the Companion Files 



• 

A link to retrieve the AutoCAD 2025 trial version, which will last for 30 days starting from the day of installation. This version will help you solve all practices and projects (if you are a college/university student, you can download a student version of the software from www.autodesk.com) 

• 

Practice files which will be your starting point to solve all practices in the book 

• 

Copy the folder named “Practices” into one of the hard drives of your computer 

• 

As for projects, you will find two folders inside, “Metric” for metric units projects, and “Imperial” for projects using imperial units 



 About the Book 

This is the most comprehensive book about AutoCAD 2025 – 2D drafting on the market. It is divided into three major parts: 

• 

 Essentials: from Chapte r 1 to Chapter 10.  It assumes that the reader has no previous experience in AutoCAD; hence it starts from scratch. Chapter 10 

contains three projects – one architectural, and two mechanical using  both Imperial and metric units. 

• 

 Intermediate: from Chapter 11 to Chapter 18.  It contains a deeper discussion on a subject we touched on in the Essentials part, or a new advance feature. 

• 

 Advanced: from Chapter 19 to Chapter 26. It discusses the most advanced features of AutoCAD 2025. 

If you don’t have any prior experience in AutoCAD this book is a perfect start, and you can stop at the end of any part. But if you want to be a real power user of AutoCAD, you should go through all 26 chapters, solving all projects and practices. 

This book is also a good source to prepare for the  AutoCAD Certified Professional exam. 

The chapters are divided as follows: 

• 

Chapter (1) covers AutoCAD basics along with the interface 

• 

Chapter (2) covers AutoCAD techniques to draw with accuracy 

• 

Chapters (3 & 4) cover all modifying commands 

• 

Chapter (5) covers the AutoCAD method of organizing the drawing using layers and inquiry commands 

• 

Chapter (6) covers the methods of creating and editing blocks, and inserting and editing hatches 

• 

Chapter (7) covers AutoCAD methods of writing text 

• 

Chapter (8) covers how to create and edit dimensions in AutoCAD 

• 

Chapter (9) covers how to plot your drawing 

• 

Chapter (10) includes three projects, one architectural and two mechanical, covering both metric and imperial units 

• 

Chapter (11) covers the creation of more 2D objects 

• 

Chapters (12 & 13) cover advanced practices and techniques 

• 

Chapter (14) covers Block tools and Block Editing 

• 

Chapter (15) covers the creation of Text Style and Table Styles along with Formulas in tables 

• 

Chapter (16) covers the creation of Dimension Style & Multileader style plus adding multileaders 

• 

Chapter (17) covers the creation of Plot styles, the meaning of Annotative, and DWF creation 

• 

Chapter (18) covers how to create a template file and customize AutoCAD 

interface 

• 

Chapter (19) covers Parametric Constraints 

• 

Chapter (20) covers Dynamic Blocks 

• 

Chapter (21) covers Block Attributes 

• 

Chapter (22) covers External Reference 

• 

Chapter (23) covers Sheets Sets 

• 

Chapter (24) covers CAD Standards and Advanced Layer Commands 

• 

Chapter (25) covers Importing PDF files, Design Views, AutoCAD Web, Mobile Apps 

• 

Chapter (26) covers the Drawing Compare Function 



CHAPTER 1 

AutoCAD 2025 Basics 

In This Chapter 

• 

Starting AutoCAD 

• 

Dealing with the AutoCAD interface 

• 

AutoCAD defaults and drawing units 

• 

Dealing with file-oriented commands 

• 

Undo and Redo commands 





1.1 STARTING AUTOCAD 

AutoCAD was released in 1982 by Autodesk, Inc., which was a small company at that time. It was designed to be used for PCs only. Since then, AutoCAD has enjoyed the largest user base in the world in the CAD business. Users can use AutoCAD for both 2D 

and 3D drafting and designing. AutoCAD can be used for architectural, structural, mechanical, electrical, environmental, and manufacturing drawings and for road and highway designs. 

Though the focus these days is BIM (Building Information Modeling), AutoCAD is still the most profitable software for Autodesk, Inc. due to the ease of use and comprehensiveness, which addresses all of the user needs. Another version of AutoCAD, called AutoCAD LT, is used for 2D drafting only. 

To start AutoCAD 2025, double-click the shortcut on your desktop that was created in the installation process. AutoCAD will present the Welcome window, as shown in the following: 









While in the welcome window, you will be able to: 

• 

Open an existing file, Open a Sheet Set, Explore the sample files that come with the software 

• 

Start a new drawing, or Download more templates accessible online 

• 

See the recent files you opened (either as a list, or as icons) 

• 

Check if AutoCAD has an Announcement for you regarding your software/hardware 

• 

Send your feedback to Autodesk 



Starting a new file or opening an existing file will show you the interface of AutoCAD 

2025, as shown in the following: 



1. Application Menu 

2. Start tab 

3. File tab 

4. Ribbon 

5. Current File Name 

6. Info Center 

7. Sign In 

8. ViewCube 

9. Navigation Bar 

10. Cross Hairs 

11. Workspace 

12. Status Bar 

13. Command Window 

14. Layout tab 

15. Model tab 

16. UCS Icon 

17. Graphical Area 

1.2AUTOCAD 2025 INTERFACE 

The AutoCAD interface is based on Ribbons and Application Menu. The most important feature of this interface is that the size of the Graphical Area will be larger. 

1.2.1 Application Menu 

The Application menu contains file-related commands: 





Included are commands such as creating a new file, opening an existing file, saving the current file, saving the current file under a new name and in a different folder, import 



from different file formats, exporting the current file to a different file format, printing and publishing the current file, etc. We will discuss almost all of these commands in different places in this book. By default, you will see the recent files. You can choose how to display the recent files in the Application Menu using this control: Also, you can choose how to sort the recent files using this control: 







1.2.2 Quick Access Toolbar 

This toolbar contains all File commands mentioned in the Application Menu along with Workspace and Undo/Redo. 



The user can customize this toolbar by clicking the arrow at the end, which will produce the following: 





As you can see, the user can add or remove commands; clicking Show Menu Bar may also be useful because the ribbon does not include all AutoCAD commands. 

Share Drawing 

This command will share a link of the current version of the drawing including its external references in AutoCAD Web, you will see the following message: 







You can create a link which people can view it only, or, with the ability to edit and save copy of it. 

1.2.3 Ribbons 

Ribbons consist of two parts: tabs and panels, as shown below: Some panels have more buttons than shown: the following is the Modify panel: 





Click the small triangle near the title and you will receive the following: 





If you move away from the panel, buttons will disappear. To make them visible always, click the push pin. The new view are as follows: 







For some commands, there are many options. To make the user’s life easier, AutoCAD 

put all the options in the same button. Refer to the following illustration: 





The ribbons have a very simple help feature. If you hover the mouse over a button, a small help screen appears: 



If the user leaves the mouse over the button for a longer period of time, AutoCAD will show more detailed help: 







Panels have two states—either  docked or  floating. By default, all panels are docked in their respective tab. Drag and drop the panel in the graphical area to make it floating. 

One important feature of making the panel floating is you will be able to see it while other tabs are active. 

You can send the panel back to its respective tab by clicking the small button at the top right side: 



While the panel is floating you can toggle the orientation: 









It will either extend to the right: 



Or down: 



The button at the end of the tab names allows you to cycle through the different states of the ribbons. The main objective of this new feature is to give you yet more graphical area. Clicking the small button will produce the following: 









1.2.4 InfoCenter 

InfoCenter is the place to access help topics online and offline, along with other tools: For instance, if you type a word or phrase in the field shown below, AutoCAD opens the Autodesk Exchange window and finds all the related topics online and offline. 

Online means all Autodesk websites along with some popular blogs. 

Use Sign In to access Autodesk Account. 

1.2.5 Command Window 

By default, the command window is floating, but you can dock it at the bottom or the top of the screen. Reading the command window all the time will save a significant amount of wasted time trying to determine what AutoCAD wants. AutoCAD will show two items at the command window: your commands and AutoCAD prompts asking you to perform a particular action (e.g., specify a point, input an angle, etc.). Refer to the following illustration: 



1.2.6 Graphical Area 

The graphical area is your drafting area. This is where you will draw all your lines, arcs, and circles. It is a precise environment with an XYZ space for 3D and an XY plane for 2D. You can monitor coordinates in the left part of the status bar. 



1.2.7 Status Bar 

The status bar in AutoCAD contains coordinates along with some important functions; some of them are for precise drafting in 2D and some of them are for 3D. 



The buttons you will see on the status bar are not necessarily all that are available. To customize this, click on the last button at the right (the one with three horizontal lines) and you will see the following list (showing some of the options): 







1.2.8 Start Tab 

When you click the Start tab at any moment, you will receive the welcome screen again. Hence, you can start a new drawing, open an existing drawing, etc. 

At the left of the Start tab, you will see three horizontal lines if you click it, you will see the following menu: 



This menu will allow you to do the same file functions of the main menu. 

1.31.3   AUTOCAD DEFAULTS 

Before using the AutoCAD environment, you should be aware of the following AutoCAD settings: 



• 

AutoCAD saves points as Cartesian coordinates (X,Y) whether metric or imperial numbers were used. This is the first method of precise input in AutoCAD to type the coordinates using the keyboard 



• 

To specify angles in AutoCAD, assume east (to your right) is your 0° and then go counterclockwise. (This is applicable only for the northern hemisphere; we will learn in Chapter 10 how we can change this setting for the southern hemisphere) 





• 

The wheel in the mouse has four zooming functions: Zoom In (move wheel forward), Zoom Out (move wheel backward), Panning (press and hold the wheel), and Zooming Extents (double-click the wheel) 

• 

Pressing [Enter] or [Spacebar] is equal in AutoCAD 

• 

When pressing [Enter] without typing any command, AutoCAD will repeat the last command. If it is the first thing you do in the current session, it will start Help 

• 

Pressing [Esc] will cancel the current command 

• 

Pressing [F2] will show the Text Window—check the following: 





1.41.4   WHAT IS MY DRAWING UNIT? 

If you draw a 6-units line in AutoCAD, what does AutoCAD really mean by 6 units? Is it 6 m, 6 ft, or neither? AutoCAD deals with whatever units you choose; if you mean 6 m, so let it be. If you mean 6 ft, AutoCAD will proceed with this assumption as well. What is important is that you be consistent throughout your file. This is true for the Model Space, where you will prepare your drafting, but when it relates to printing, you have to recall your assumption and set your drawing scale accordingly. In Chapter 9, 

printing will be discussed. At the bottom left of the screen, you can see the model tab and the layouts, as shown in the following: 







1.51.5   CREATE A NEW AUTOCAD DRAWING 

This command will create a new drawing based on a premade template. Use the Quick Access Toolbar and click the New button: Or you can click the (+) sign in the File tab: 







You will see the following dialog box: 



Do the following steps: 

• 

Select the desired template file (AutoCAD template files have the extension 

* .dwt). AutoCAD 2025 includes many premade templates that you can use (it is preferable for the companies to create their own template files). 

• 

Once you are done, click the Open button 

• 

AutoCAD AutoCAD will start with a new file (which has a temporary name like Drawing1.dwg; you should, however, rename it to something meaningful) NOTE 

 In the Start tab under New  drop-down, you can do the same, as shown below: 







1.61.6   OPEN AN EXISTING AUTOCAD DRAWING 

This command will open an existing drawing file for additional modifications. From the Quick Access Toolbar, click the Open button: You will see the following dialog box: 







Complete the following steps: 

• 

Specify your desired drive and folder 

• 

You can open a single file by selecting its name from the list and clicking the Open button, or you can double-click on the file’s name. Or, you can open more than one file by selecting the first file name, holding the [Ctrl] key, clicking the other file names in the list (which is a common MS Windows skill), and then clicking the Open button 

1.6.1 File Tab 

Using the File tab beneath the ribbon, you will see a tab for each opened file, as in the following: 



The color used is gray. The current file (tab) will appear in a lighter gray, and the other tabs will appear in a darker gray. If you hover over one of the tabs, two actions will happen: 

• 

The path of this file will appear 





• 

The model space and the layouts of this file will appear beneath See the following: 



There will be a blue frame around the model space view. Moving your mouse to the right will show the layouts in the graphical area; if you find what you are looking for, click the layout view to move to it 

. 

NOTE 

• 

 A star beside the name of the file in the file tab means this file was modified and you need to save changes 

• 

 Click (×)  beside the name to close the file, hence closing the tab 

• 

 The user can customize the File tabs and the Layout tabs by switching them off; all you have to do is to go to the View  tab and locate the Interface  panel; the two buttons will be blue if the tabs are on, but if you want to turn them off, click once on each button: 



• 

 You can now drag a file tab off of the AutoCAD application window, making it a separate window. This is good for multi-display setup. At any moment, you can 



 right-click the title bar of a floating drawing window you will see the following options: 



• 

 These options will help the user to Move the file back to File Tab, pin the floating window, Save and Save As the floating window, close it, and Copy File Path, and File Location 

1.71.7   CLOSING DRAWING FILES 

This command will close the current opened files or all opened files, depending on the command you choose. Use the Application Menu, move your mouse to the Close button, then select either Current Drawing to close the current file, or All Drawings to close all the opened files in single command: 





If any of the open files were modified, AutoCAD will ask if you want to save or close without saving, as in the following dialog box: 







1.81.8   UNDO AND REDO COMMANDS 

Undo and Redo are to help you to correct mistakes. They can be used in the current session only. 

1.8.1 Undo Command 

This command will undo the effects of the last command. You can reach this command by going to the Quick Access toolbar and clicking the Undo button. If you want to undo several commands, click the small arrow at the right. You will see a list of the commands; select the group and undo them: 





Also, you can type u at the command window (do not type undo, because it has a different meaning), or press Ctrl + Z at the keyboard. 

1.8.2 Redo Command 

This command will undo the undo command. You can reach this command by going to the Quick Access toolbar and clicking the Redo button. If you want to redo several commands, click the small arrow at the right. You will see a list of the commands; select the group and redo them: 



Also, you can type redo at the command window or press Ctrl + Y. 

PRACTICE 1-1 AUTOCAD BASICS 

1.  Start AutoCAD 2025 

2.  Open the following files: 



a.  Ground Floor 



b.  Mechanical-1 



c.  Mechanical-2 

3.  Using the File tab, check the three files and their layouts 4.  Use the different zoom techniques with the mouse wheel 5.  Using the Application menu, close all files without saving NOTES 





 








CHAPTER REVIEW 

1.  The File tab will show the Model space and layouts of the opened files a.  True 



b.  False 

2.  The AutoCAD template file extension is _________ 



a.  *.dwt 



b.  *.dwg 



c.  *.tmp 



d.  *.temp 

3.  AutoCAD units can be a meter or foot, per user desire a.  True 



b.  False 

4.  Moving the wheel forward will mean _________ 

5.  To undo any command in AutoCAD you can: 



a.  Click the Undo icon from the Quick Access Toolbar b.  Type u at the command window 



c.  Type [Ctrl] + Z 



d.  All of the above 

6.  Ribbons consist of _________ and _________ 

7.  The Menu bar by default is not shown, but you can show it if you want to: a.  True 



b.  False 

8.  The AutoCAD drawing file extension is _________ 

9.  Positive angles in AutoCAD are created by moving in this direction: _________ 




CHAPTER REVIEW ANSWERS 

1.  a 

3.  a 

5.  d 

7.  a 

9.  CCW (counterclockwise) 






CHAPTER 2 

Precise Drafting in 


AutoCAD 2025 

In This Chapter 

• 

What are the drafting priorities? 

• 

How to draw lines, circles, and arcs using precise methods 

• 

How to draw polylines using precise methods 

• 

How to convert lines and arcs to polylines and vice versa 

• 

What are Object Snap and Object Track? 





2.1 DRAFTING PRIORITIES 

While you are drafting, there are two main concerns in your mind: the accuracy of your drawing and how fast you can finish it. People crave to finish their drawings fast but without weakening the drawing’s accuracy. Experts tend to put accuracy ahead of fast production. 

Accuracy is important in the context of the “life cycle” of the drawing. If your drawing is accurate, all the other people who will modify it in the future will be able to do their mission without a hassle. On the other hand, their lives will be extremely difficult if you finish your drawing fast but none of the objects are accurate. 



In this chapter, you will learn how to use the four most essential drafting commands, which are: 

• 

Line command, to draw line segments 

• 

Arc command, to draw circular arcs 

• 

Circle command, to draw circles 

• 

Polyline command, to draw lines and arcs jointly 

While we are discussing the four drafting commands, we will introduce accuracy tools, which will help you accelerate the drafting process. 

2.2 DRAWING LINES USING LINE COMMAND 

This command will enable you to draw straight lines; each line segment presents a single object. To issue this command go to the Home tab, locate the Draw panel, and then select the Line button: 



You will see the following AutoCAD prompts: 

Specify first point: 

Specify next point or [eXit/Undo]: 

Specify next point or [Close/eXit/Undo]: 

Specify next point or [Close/eXit/Undo]: Using the first prompt, specify the coordinates of your first point. Keep specifying points, and when you are done, do one of the following: 

• 

If you want to stop without closing the shape, use either X to exit the command, or press [Enter] ([Esc] will do the job as well, but don’t make it a habit, as [Esc] 

generally means abort) 

• 

If you want to close the shape and finish the command, press C on the keyboard or right-click and select the Close option 

• 

If you made any mistakes, you can undo the last point by typing U on the keyboard or right-clicking and selecting the Undo option This is what the right-click menu looks like: 





2.3 WHAT IS DYNAMIC INPUT IN AUTOCAD? 

Dynamic Input has multiple functions: 

• 

It will show prompts at the command window in the graphical area 

• 

It will show the lengths and angles of the lines before drafting, which will specify them accurately 

In order to turn on/off the Dynamic Input, click the following button on the Status bar: 







2.3.1 Example for Showing Prompts 

By default, if you type any command using the command window, AutoCAD will help you by showing all the commands starting with the same letters, as in the following example: 



We typed the letter m, and accordingly AutoCAD gave us all the commands starting with this letter. While Dynamic Input is on, this is applicable to the crosshairs as well, as in the following: 









Let’s assume we started the command window, using either way. Once you press 

[Enter], the following prompt will appear: 



Type in the x and y coordinates, using the [Tab] key to move between the two fields: 2.3.2 Example for Specifying Lengths and Angles 

Once you specify the starting point, AutoCAD will use Dynamic Input to show the length and the angle of the line utilizing the rubber band mode: 







NOTE 

 Angles are measured CCW starting from the east, but only for 180° , unlike the angle system in AutoCAD, which will be for the whole 360°. 

Type the length of the line, then press [Tab] to input the angle (it will give 1o increments); once you are done, press [Enter] to specify the first line. Continue doing the same for the other segments: 



If Dynamic Input button is not shown, click the three lines at the bottom right of the screen and turn it on. 

PRACTICE 2-1 DRAWING LINES USING DYNAMIC INPUT 

1.  Start AutoCAD 2025 

2.  Open file Practice 2-1.dwg 

3.  Using status bar, click off, Polar Tracking, Ortho, and Object Snap, and make sure Dynamic Input is on 



4.  Draw the following shape, using 0,0 as your start point, bearing in mind all sides = 4, and all angles are multiples of 45°: 





5.  Save the file and close it 

2.4 EXACT ANGLES (ORTHO VS. POLAR TRACKING) 

When using Dynamic Input angles are incremented by 1°, but still the user cannot depend on it to specify angles precisely in AutoCAD. 

The Ortho function will force the lines to be at right angles (orthogonal) using the following angles: 0, 90, 180, and 270. 

In order to turn on/off the Ortho,  use the following button in the status bar: 







However, what if we want to use other angles such as 30, 45, 60, etc.? Ortho will not help in this case; for this reason, AutoCAD introduced another function called Polar Tracking, which will show in the graphical area rays starting from the current point heading toward angles like 30, 45, etc. Since Ortho and Polar Tracking contradict each other, when you switch one on, the other will be turned off automatically. In order to turn on/off Polar Tracking, use the following button in the status bar: If you click the small triangle at the right of the button, you will see the following menu: 





You can select the desired angle or select Tracking Settings to change some of the default settings of Polar Tracking. You will see the following dialog box: 
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